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What's New in Author-it 5? 
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General Information 

 Author-it 5 was recoded on .NET application platform. 
 All releases since the initial 5.0 release (fall 2007) include 
performance improvements and bug fixes. 

 The latest release is the best!  
 Continuous development process rolls out new features in 
planned quarterly releases.  

 Information about the upgrade process is available in a 
separate free webinar.  

 See release notes on the Author-it Knowledge Center 
(http://www.author-it.com/kc/index.mv) for more details.  

 Author-it 5.2 provides support for structured authoring.  
 

http://www.author-it.com/kc/index.mv
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New Features - 5.0.8.317 & 5.0.10.510 

Author-it 5.0.8.317 (24-Sep-2007) 

 New graphical user interface 
 Publishing profiles 
 Active Directory integration 
 New licensing model 
 Author-it Xtend (optional module) 
 Integrated Project Manager (optional module) 

Author-it 5.0.10.510 (12-Dec-2007) 

 Integration with acrocheck™ 
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New Features - 5.0.11.625 & 5.0.12.670 

Author-it 5.0.11.625 (13-Feb-2008) 

 Improved table layout controls 
 Quick Tables 
 Recently Used Styles listing 
 Support for Word 2007 .dotm (macro-enabled template) files 

Author-it 5.0.12.670 (14-Apr-2008) 

 UTF-8 used in dhtml_search.js and dhtml_search.htm files 
 Publishing Profiles: Can use the Theme tab to substitute any 
object type that can be placed into the Book Contents (e.g., 
Title Page, TOC, Index) as well as Styles and Media objects. 
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New Features - 5.1.15.759 

Author-it 5.1.15.759 (23-Jul-2008) 

 Object variants 
 Quick Search 
 Drag and drop to create file objects 
 Preview pane location setting 
 Quick Access toolbar 
 Topic content reference tags 
 Publishing profile can create additional book XML output 
 Publishing profile can run specific Word macros 
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New Features - 5.2.71.2359 

Author-it 5.2.71.2359 (28-Jan-2009) 

 Structured authoring for topics 
 Paste and format content using an import profile 
 Save, rename, and export Quick Search settings 
 Email a link to an Author-it topic 
 Publish to DITA 1.1 

Author-it Live (5.2.8.1766) 

 Support for object variants 
 Can create topics based on structured templates (but cannot 
validate topics or create structured templates) 

 



 

Published  on Monday, March 29, 2010 Copyright © 2008. SDI Intelligent Solutions Slide 7 of 54 
 

New Features - 5.3.48.4159 

 Structured authoring for books and enhanced structure control 
for topics 

 Web Help templates  
 Support for Microsoft Word 2007 Save as PDF feature 
 New Spell Check dictionaries 
 Option for creating a sitemap file 
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New Features - 5.3.121.4749 

 Japanese IME enhancements make it easier to enter 
Japanese text in the Editor. 

 Administrator setting controls whether changing release states 
marks objects as modified. 
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New Features - 5.3.211.6412 

 Enhanced reliability for embedded topics, including an 
Embedded Topics Best Practice Guide 
(http://kc.author-it.com/#b45755t49639n19875).  

 Enhanced capabilities for using the acrocheck plugin for 
Author-it. 

 Web Help template updates.  
 Performance improvements for Author-it and the Localization 
Manager.  

 Default file encoding for publishing to web formats is now 
UTF-8.  

 

http://kc.author-it.com/#b45755t49639n19875
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New Features - 5.3.311.6519 

 Improved import process for RoboHelp 8 projects.  
 Publishing to XML includes publishing profiles and their 
variable assignments.  

 New Author-it Software License Agreement included in 
installation folder and Knowledge Center.  

 



 

Published  on Monday, March 29, 2010 Copyright © 2008. SDI Intelligent Solutions Slide 11 of 54 
 

New Features - 5.3.316.6868 

 File encoding settings in template files that are not UTF-8 is 
honored.  
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New Features - 5.3.427.7073 

 Publishing profile Actions tab now includes option to set file 
and folder to be opened after publishing.  

 Publishing log shows publishing profile description instead of 
output format type.  

 When publishing to Word 2007, output document type 
depends on template type:  
 .dotx > .docx 
 .dotm > .docm 
 .dot > .doc 
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New Features - 5.3.427.7073 - cont'd 

 Web Help templates provide controls for messages and user 
interface text to be translated and for highlighting in the table 
of contents. 

 Tables published to HTML include class attributes that can be 
used to control CSS styling of tables.     

 File objects for graphics pasted into a topic will be named 
using the topic description when the topic is saved.   

 You can re-import HTML files and replace Author-it objects 
that were previously imported from the same files.  
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Interface Changes 
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General Changes 

 Commands are displayed in a ribbon, with tabs and command 
groups for different roles and functions. 

 Contextual right-click commands are still available. 
 New icons represent objects and actions. 
 Accordions in the Navigation Pane can be selected for 
different functions, and their display can be customized 

 File menu options, user options, and recently opened libraries 
are now available from the Author-it button (top left corner). 

 
 Help options are available from the Help button at the top right 
of the main window or Book Editor. 
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Book Editor Changes 

 Ribbons organize authoring task commands. 
 New navigation tabs show books that use the current topic and 
provide access to search. 

 Tabs can be repositioned and docked (including search 
results). 

 Topic text size can be increased or decreased using zoom 
slidebar. 
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Enhanced Functions 

 Search criteria include folders, groups and users, multi-select 
capability, and controls for matching case and complete words. 

 Show Relationships dialog includes number of uses. 
 Templates and styles can be organized in subfolders to control 
how they are displayed to writers. 

 Unicode Support 
 Layout tab provides table commands when you are working 
with a table. 
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Table Enhancements (5.0.11.625) 

 New feature allows you to use preformatted Quick Tables to 
quickly insert standard tables into your document. 
 Create a separate topic for each Quick Table format (with or without 
standard text). 

 Designate a folder that contains Quick Tables.  

 Allow Row Breaks command lets you control where a long 
table is broken (or not broken) across pages in your printed 
output. 

 You can specify the exact height used by a row, or width by a 
column, using the cell size measurement selectors. 

 You can change the direction of text in a selected cell. 
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Publishing Changes 
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About Publishing Profiles (5.0) 

 Author-it 5 provides default profiles for each type of output 
(print, web, help, ...). 

 Add other profiles for specific publishing requirements. For 
example: 
 Rebranded outputs 
 Draft vs. final publishing 
 A4 paper size publishing 

 Customize the publishing process for different roles (organize 
profiles in folders with permissions). 
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Conditional Publishing 

 Publishing profiles control:  
 Types of output available for each type of book (book templates) 
 Release states to be published 
 Replacement of specific objects included in the book 
 Exclusion of objects by release state, folder, or variable assignments 
 Actions performed before or after publishing 
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New Publishing Options (5.1.15.759) 

 Object reference tags to indicate where topic content starts 
and ends can be inserted into content when publishing to 
XHTML. 

 A new Book XML action provides the option for the book being 
published to also be published to Author-it XML. 

 A publishing profile option to execute various Word macros 
before or after publishing is provided by the new Word Macro 
feature. 
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Web Help Templates 

 Web Help publishing templates provide a "virtual frameset" 
output using Javascript and CSS. 

 Provide a more modern and interactive online format: 
 Breadcrumb navigation 
 Feedback and email links 
 Enhanced search 
 Customized themes or "skins" 

 Setting up Web Help requires importing new objects to support 
the new publishing application 
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New Publishing Options - 5.3.48.4159 

 Support for Word 2007 Save as PDF provides clickable 
hyperlinks and TOC links for PDF output (used by default if the 
plugin is installed).  
 More complete than publishing directly to PDF using Acrobat, but still limited 
 Difficult to uninstall  

 To publish a sitemap, include the Base URL on the Web tab of 
your book object 
 Useful for content that needs to be crawled by search engines 
 Base URL is added to each filename for the site to create sitemap entries 
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Structured Authoring (5.2 & 5.3) 
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Planning for Structured Authoring 

 Structured authoring uses structured templates to control use 
of objects in books or content elements within topics.  

 Decide what structured templates you will need for different 
types of books and topics. 

 Will you be converting existing objects? 
 Identify release states that require validation.   
 Define structure requirements for each structured book and 
topic type. 

 Test structured authoring in a sandbox library first.  
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Structured Authoring and XML 

 Structured authoring does not provide native XML editing 
capability against a DTD or schema.  

 The main design goal is to provide the ability to standardize 
book or topic structure without the need for XML. 

 Structured authoring does enable you to create structures that 
are compatible with XML requirements. You can: 
 Publish to DITA, XHTML, or Author-it XML, then ... 
 Clean up using an XML editor, or ... 
 Perform an XML transform using XSLT or other transformation method. 
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Validation 

 Validation enforces rules defined in a structured template. 
 For structured objects, validation occurs when you: 

 Save the object. 
 Choose Review>Structured Authoring>Validate.  
 Assign a structured template to the object. 
 Modify a structured template. 

 Validation can be required for specific release states. 
 When structured template changes affect existing objects, you 
can: 
 Apply a new release state (e.g., Invalid). 
 Create a duplicate of the object or template.  

 The Rule tab shows validation status at the element level.  
 Object validation status is displayed in folders and search 
results.  
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Topic Structures (5.2 & 5.3) 

 For topics, you can create rules for the following elements: 
 Paragraph styles 
 Inline content (character styles, file objects, embedded topics, hyperlinks, 
and variables) 

 Tables and table cells (use of paragraph styles within tables)  
 Groups of paragraph and table rules 

 The initial release of Structured Authoring (5.2) only supported 
paragraph style rules. 
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Book Structures (5.3) 

 For books, you can define rules for the following elements: 
 Front and back matter objects (title page, TOC, TOF, Glossary, and Index) 
 Topics and topic template usage 
 Subbooks and book template usage 
 File objects 

 Book rules were added to Structured Authoring in 5.3.  
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Implementing Structured Authoring 

1 Create a model object that explains the required structure.  
2 Define release states for stages of validation: Invalid, Valid, Ready for 

Translation (Valid). 
3 In an object template, select Make this object a structured template on the 

General tab. 
4 In a folder, select the template and choose Manage>Data>Structure Builder. 
5 Create element rules using the following criteria: 

 Number of occurrences 
 Fixed (use a specific rule) or Flexible (choose from adjacent Flexible rules) 
 Which elements or templates can be used for the rule 

6 Assign your model object as an example.  
7 Identify release states that enforce validation (for publishing, also include 

the release state in a publishing profile). 
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Integration with Active Directory 
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Simplified Group and User Definitions 

 Active Directory Groups defined by network administrator. 
 Using Author-it Administrator, map Author-it groups to Active 
Directory groups. 

 For existing Author-it users, map to users defined in Active 
Directory.  

 For new users, being added to Active Directory Group 
automatically creates a user and group definition in Author-it.  

 When network administrator moves a person to a different 
group, Author-it group definitions are automatically updated.  

 Author-it users can log into an Author-it library as a trusted 
user (without additional password).  
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New Licensing Model 
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Licensing Changes 

 Base User Licenses provide core functions. 
 All Base User Licenses are floating licenses. 
 Extended licenses for specific users:  

 Project Manager users 
 Offline Authoring users 
 MIF Import 
 Localization Manager users 

 All license information is stored in the library (entered through 
Administrator) 

 Enterprise Edition licenses are upgraded to a SQL Server 
Connector plus same number of Base User Licenses. 
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Server Capability Licenses 

 SQL Database Connector 
 Localization Manager locales 
 Author-it Xtend (memory indexing server) 
 Author-it Live (web editor) 
 Publishing Server 
 Integration Server (free) 
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Integrated Project Manager 

 Project Manager now included in Library Explorer view. 
 If licensed, Project Manager and Task functions are now 
available through accordion tabs in the Editor.  
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Other Changes 
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Recently Used Styles (5.0.11.625) 

 Paragraph and character styles used in the current session 
appear in a pick list on the style drop-down menu.  
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Object Variants (5.1.15.759) 

 New Object Variants feature enables you to create and 
maintain different variations of a single object. 

 You can have multiple variants active at any one time. 
 Variable definitions include an option to define a variable as a 
variant criteria.  

 Criteria control how variants are displayed or published in a 
book.  

 Select criteria values when creating variants, filtering book 
contents, or publishing. 

 Can be used with Author-it Live in 5.2. 
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Enhanced Functions (5.1.15.759 & 5.2.71.2359) 

 Quick Access toolbar is available in the main Library Explorer 
window, allowing you to navigate between recently accessed 
folders and to open the Quick Search window 

 Quick Search also accessible from Book Editor 
 In 5.1, Quick Searches were only persistent for the current 
session, and could not be renamed or exported) 

 In 5.2, Quick Search feature allows you to perform an 
advanced search: 
 Save search criteria, allowing updated results at any time without re-entering 
search criteria (Refresh to update results) 

 Rename saved searches 
 Export search results to .csv and view in a spreadsheet or other application 
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Enhanced Functions (5.1.15.759 & 5.2.71.2359) 

 Use Drag & Drop to create new file objects 
 Preview Pane Position setting under User Options allows you 
to set the preview pane display at the right or the bottom of the 
main window 

 Drag a topic from Author-it folder into an email message to 
email a link to the topic (recipient must have Author-it client 
software) 
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Paste Using an Import Profile (5.2.71.2359) 

 Enable use of an import profile for pasting by selecting Use for 
Paste on profile properties. 

 To paste using a profile, select from toolbar: 
Edit>Clipboard>Paste (dropdown)>Paste Using Import 
Profile>Profile Name. 

 Not available as a right-click option.  
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New Spell Check Dictionaries (5.3) 

 18 new dictionaries 
 Installed automatically with 5.3 
 May need to reset dictionary selection  in User Options 
 Updates to old dictionaries are stored and can be added to 
new dictionaries 
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(Some) Changes Not Mentioned in Release Notes 

 Main window remembers previous folder location.   
 Find function only finds terms in headings and text within 
topics (not object properties) 

 Publishing log shows cross references that do not map to 
topics included in the book. 

 Importing an XML file that includes variables into a different 
library now prompts for creation of variables if they do not 
exist.  

 Double click on a command ribbon tab to hide or display the 
ribbon.  
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Author-it Xtend (5.0.8.317) 
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Automating Reuse 

 Author-it Xtend provides advanced capabilities for reuse of 
content. 

 It requires a SQL Server database and an Author-it Xtend 
server license. 

 Suggestive reuse popup displays possible existing content that 
matches the words you type. 

 Color highlighting displays identical or similar paragraphs in 
existing topics. 

 Displays are configurable for each user.  
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Benefits 

 Find content easily by typing keywords in a new topic. 
 View existing content in the context of a complete topic.  
 Copy content at the paragraph level. 
 Paragraphs in different topics can be edited independently, but 
identical paragraphs are only stored once.  

 Choose to paste or embed a topic when appropriate. 
 Reduce review time and localization costs by reusing existing 
content that has already been approved or translated. 
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Author-it Live (4.5) 
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Web-Based Editing 

 Access Author-it through a web browser (currently only 
Internet Explorer). 

 No client software to install. 
 Simplifies administration of software, users, and library.  
 Supports contractors, remote writers, and traveling staff. 
 Does not include import and design capabilities.  
 Publishing Server provides publishing capability for the web 
editor.  
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Author-it Localization Manager (4.1.444) 
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Localization Manager Overview 

 Licensed per user or locale in Author-it 5. 
 Unicode support. 
 Manages new and changed content for each language/locale. 
 Ensures shared content is only translated once (for all 
documents and output formats). 

 Content is packaged as XML that can be sent to translators 
and translated using translation memory applications.  

 Translated content is published from Author-it (for all 
documents and output formats). 
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Integration Server (4.5) 

 Integration Server provides a Web Services API that enables 
programmatic access to Author-it libraries.   

 Enables programmed interaction with other Enterprise 
applications.  

 Reference information is available on the Author-it 
Knowledge Center (http://www.author-it.com/kc/index.mv). 

 Available free on request.  
 

http://www.author-it.com/kc/index.mv
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Additional Resources 

 Other free webinars and training opportunities are described 
on our Author-it web pages 
(http://www.sdicorp.com/authorit).  

 

http://www.sdicorp.com/authorit
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